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Legal information 
Use of application examples 

Application examples illustrate the solution of automation tasks through an interaction of several 
components in the form of text, graphics and/or software modules. The application examples are 
a free service by Siemens AG and/or a subsidiary of Siemens AG (“Siemens”). They are non-
binding and make no claim to completeness or functionality regarding configuration and 
equipment. The application examples merely offer help with typical tasks; they do not constitute 
customer-specific solutions. You yourself are responsible for the proper and safe operation of the 
products in accordance with applicable regulations and must also check the function of the 
respective application example and customize it for your system. 

Siemens grants you the non-exclusive, non-sublicensable and non-transferable right to have the 
application examples used by technically trained personnel. Any change to the application 
examples is your responsibility. Sharing the application examples with third parties or copying the 
application examples or excerpts thereof is permitted only in combination with your own products. 
The application examples are not required to undergo the customary tests and quality inspections 
of a chargeable product; they may have functional and performance defects as well as errors. It is 
your responsibility to use them in such a manner that any malfunctions that may occur do not 
result in property damage or injury to persons. 
 

Disclaimer of liability 
Siemens shall not assume any liability, for any legal reason whatsoever, including, without 
limitation, liability for the usability, availability, completeness and freedom from defects of the 
application examples as well as for related information, configuration and performance data and 
any damage caused thereby. This shall not apply in cases of mandatory liability, for example 
under the German Product Liability Act, or in cases of intent, gross negligence, or culpable loss of 
life, bodily injury or damage to health, non-compliance with a guarantee, fraudulent 
non-disclosure of a defect, or culpable breach of material contractual obligations. Claims for 
damages arising from a breach of material contractual obligations shall however be limited to the 
foreseeable damage typical of the type of agreement, unless liability arises from intent or gross 
negligence or is based on loss of life, bodily injury or damage to health. The foregoing provisions 
do not imply any change in the burden of proof to your detriment. You shall indemnify Siemens 
against existing or future claims of third parties in this connection except where Siemens is 
mandatorily liable. 

By using the application examples you acknowledge that Siemens cannot be held liable for any 
damage beyond the liability provisions described. 
 

Other information 
Siemens reserves the right to make changes to the application examples at any time without 
notice. In case of discrepancies between the suggestions in the application examples and other 
Siemens publications such as catalogs, the content of the other documentation shall have 
precedence.  

The Siemens terms of use (https://support.industry.siemens.com) shall also apply.  
 

Security information 
Siemens provides products and solutions with industrial security functions that support the secure 
operation of plants, systems, machines and networks. 

In order to protect plants, systems, machines and networks against cyber threats, it is necessary 
to implement – and continuously maintain – a holistic, state-of-the-art industrial security concept. 
Siemens’ products and solutions constitute one element of such a concept. 

Customers are responsible for preventing unauthorized access to their plants, systems, machines 
and networks. Such systems, machines and components should only be connected to an 
enterprise network or the Internet if and to the extent such a connection is necessary and only 
when appropriate security measures (e.g. firewalls and/or network segmentation) are in place.  

For additional information on industrial security measures that may be implemented, please visit 
https://www.siemens.com/industrialsecurity. 

Siemens’ products and solutions undergo continuous development to make them more secure. 
Siemens strongly recommends that product updates are applied as soon as they are available 
and that the latest product versions are used. Use of product versions that are no longer 
supported, and failure to apply the latest updates may increase customer’s exposure to cyber 
threats. 

To stay informed about product updates, subscribe to the Siemens Industrial Security RSS Feed 
at: https://www.siemens.com/industrialsecurity. 

https://support.industry.siemens.com/
https://www.siemens.com/industrialsecurity
https://www.siemens.com/industrialsecurity
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1 Introduction 

1.1 Overview 

Almost 97 percent of the water on earth is saline and cannot be used as drinking 
water or for irrigation purposes. Desalination of seawater offers an opportunity to 
obtain additional drinking or process water for people, industry and agriculture. 
Efficient automation solutions are required to ensure the supply of fresh water, 
especially in dry areas. 

There are two types of processes for the desalination of seawater: 

 Thermal processes such as multi-stage flash distillation (MSF) 

 membrane processes such as reverse osmosis 

The processes for desalinating seawater are very energy-intensive. In direct 
comparison, pressure-driven membrane processes generally require slightly less 
energy than thermal processes. 

Seawater desalination based on reverse osmosis uses semipermeable membranes 
to filter the dissolved salt from the seawater. For this purpose, the salt water is 
pressed through the membranes at a higher pressure than the osmotic pressure of 
the salt water. The high energy input is necessary to generate the high pressure in 
front of the membrane. 

A seawater desalination plant contains several sub-processes, which are shown 
schematically in the following figure. 

Pre-treatment 1Seawater intake Desalination Process 2 Post-treatment 3

 

1. Pre-treatment: 
The salt water is cleaned of dirt and sand by mechanical filtration and 
ultrafiltration. In addition, the pH value is balanced and bacteria is killed by 
adding chlorine. 

2. Desalination process: 
In the actual desalination process, the salt water is pressed at high pressure 
into a filter system containing a large number of osmosis membranes.  
The osmotic pressure of the sea water must be overcome (reverse osmosis). 
The product is purified water and the by-product brine. 
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3. Post-treatment: 
Finally, the pH value is regulated again and the drinking water is enriched with 
minerals. 

Detailed information on the application background can be found in \3\. 

1.2 Principle of operation 

Only the central desalination process is covered in this application example. 

A high-pressure pump (1) is used to lift the pressure of the pre-purified seawater to 
a level that significantly exceeds the osmotic pressure of seawater (approx. 30 
bar). The filter membranes (2) allow only the water molecules to pass through and 
retain the dissolved salt. This separates seawater into water with a very low salinity 
(permeate) and water with a very high salinity (retentate). 

The still very high pressure at the retentate outlet can be recovered to a very large 
extent with a pressure exchanger (3). Together with the booster pump (4) a part of 
the fresh sea water is lifted to the pressure level of the high pressure side. In this 
way, a large part of the energy consumed by the high-pressure pump at the inflow 
is saved. 

The PID controls for the high-pressure pump and the booster pump are supplied 
with their respective setpoints by a superimposed multi-variable controller. This 
enables a constant production quantity and product quality, as fluctuations are 
automatically compensated without operator intervention.  

21

34
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Overview picture 

This process picture contains a schematic representation of a seawater 
desalination plant. The components of the schematic representation are described 
in section 1.1 "Overview". 

 

Process picture 

The reverse osmosis process picture shows all process tags, drives and controllers 
required for operation of the plant unit. 

The majority of the process tags are analog value displays, which show the 
(simulated) process values as well as violations of specified upper or lower limits. 
The displayed block symbols and faceplates are part of the PCS 7 Advanced 
Process Library. 

Note Further information can be found in the manual "SIMATIC Process Control 
System PCS 7 Advanced Process Library": 
https://support.industry.siemens.com/cs/ww/en/view/109754967 

 

https://support.industry.siemens.com/cs/ww/en/view/109754967
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Control concept 

A multi-variable controller (MPC) is used to control flow rate and salinity (salt 
concentration) of water. This controller manipulates the process via setpoint values 
for the pressure at the membrane and the flow rate in recirculation. 

In the MPC, the different target values are weighted differently. Product quality 
(salinity) has the highest priority but remains within its dead zone during normal 
operation. The controller only has to intervene if the salinity should be higher than 
permitted. Therefore, the main controlled variable in normal operation is the 
production output (permeate flow).  

The electrical power consumption of high-pressure pump and booster pump are 
low-priority controlled variables. The target values correspond to the operating 
points with optimum pump efficiency. 

PID controllers "PIDConL" of the APL are used for the flow of recirculation and 
pressure at the membrane, which are slave controllers for the MPC master 
controller. 

 

1.3 Used hardware and software components 

This application example was created with the following hardware and software 
components: 

Component Note 

SIMATIC PCS 7 ES/OS IPC547G W7 For the PCS 7 V9.0 SP1 example project 

SIMATIC PCS 7 V9.0 SP1 Part of SIMATIC PCS 7 ES/OS IPC547G 
W7 

S7 PLCSIM Not a part of SIMATIC PCS°7 V9.0 SP1, 
additional licenses required 

APL V9.0 SP1 Part of SIMATIC PCS 7 V9.0 SP1 

 

Note If the hardware is different, observe the minimum requirements for installing the 
software components. The minimum requirements can be found in the PCS 7 
Readme at the following link: 
https://support.industry.siemens.com/cs/ww/en/view/109750097. 

 

This application example consists of the following components:  

Component Note 

109741119_WUT_SeawaterDesalination_PROJ_PCS7V90SP1.zip PCS 7 V9.0 SP1 
example project 

109741119_WUT_SeawaterDesalination_DOC_PCS7V90SP1_en.pdf This document 

 

https://support.industry.siemens.com/cs/ww/en/view/109750097
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2 Preparation and commissioning 

2.1 Preparation 

The following instructions describe the commissioning of the Unit Template, in 
which the controller is simulated with the program "S7-PLCSIM". If a real controller 
is available, you must configure the hardware components in the HW configuration. 

1. Copy the file 
"109741119_WUT_SeawaterDesalination_PROJ_PCS7V90SP1.zip" into any 
folder on the configuration computer and then open the SIMATIC Manager. 

2. Click on "File > Retrieve" in the menu bar and select the file 
"109741119_WUT_SeawaterDesalination_PROJ_PCS7V90SP1.zip". Then 
confirm by clicking on "Open". 

3. Select the folder in which the project is to be saved and confirm with "OK".  
The project is retrieved. 

4. Confirm the "Retrieve" dialog with "OK" and then click "Yes" in the dialog to 
open the project. 

5. Right-click on "Desalination_OS > OS01 > WinCC Appl. > OS" and click on the 
menu command "Open object". 

6. Confirm the dialog "Configured server not available" with "OK". 

7. Right-click the properties of your computer in the WinCC Explorer and click on 
the button "Use Local Computer Name" in the opened properties dialog. 

 

8. Confirm the message "Change computer name" with "OK". 

9. Click on "File > Exit" in the WinCC Explorer and select "Exit WinCC Explorer" 
in the following dialog. 

10. Then confirm with "OK". 

11. Open the WinCC Explorer again, as described in step 5. 

12. Open the "Tag Management" by double-clicking it.  

13. Right-click in the WinCC Configuration Studio on "Tag Management > 
SIMATIC S7 Protocol Suite > TCP/IP" and select the menu command "System 
parameters". 

14. Check the specified "Logical device name" in the tab "Unit". If the "S7-PLCSIM" 
program is used, "PLCSIM(TCP/IP)" is selected as the device name. 
The program must be restarted after changing the device name. Open the 
WinCC Explorer again, as described in step 5. 
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2.2 Commissioning 

The following instructions describe how to initialize the Unit Template. The project 
contains an SFC which drives the system automatically to a predefined operating 
point after starting.  

For commissioning it is assumed that the SIMATIC Manager has already been 
opened and the Unit Template is selected in the component view. 

Starting the simulation (S7 PLCSIM) 

To start the simulation, proceed as follows: 

1. Select "Options > Simulate Modules" from the menu. 
The "S7-PLCSIM" dialog window opens. 

2. In the dialog "Open project", select the "Open project from file" option. 

3. Select the file "Desalination.plc" from the path 
<Project path>\Desalina\Desa_MP\Desalination.plc>. 

4. In the menu, change "PLCSIM(MPI)" to "PLCSIM(TCP/IP)".  

5. In the menu, select "Run > key switch position > RUN-P". 

6. Switch to the component view of the SIMATIC Manager and select 
"Desalination_AS > AS01". 

7. Click on "PLC > Download" in the menu bar and confirm the dialog "Download" 
with "Yes". 

8. Confirm the dialog "Stop Target Modules" with "OK" and then the dialog 
"Download" with "Yes". 

Activate OS (WinCC runtime) 

Proceed as follows to activate the OS: 

1. Right-click "Desalination_OS > OS01 > WinCC Appl. > OS" and select the 
"Open Object" menu.  

2. To activate the OS (WinCC Runtime), select the menu item "File > Activate" in 
the WinCC Explorer. 

3. In the dialog "System Login", enter the user "Unit" as "Login" and "Template" 
as the password; then confirm with "OK". 

4. Select "RevOsmosis" in the picture tree area. 
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2.3 Components of process visualization 

1

2

3

4

5

 

The process screen consists of the following main components: 

1. Inflow (Feed) 

2. Recirculation (abbreviation: Recirc) 

3. Permeate 

4. Brine 

5. MPC 

 

Function Description 

Feed The temperature and flow rate of the salt water from the pre-treatment 
and the pressure control by means of a high-pressure pump are 
displayed at the inlet. 

Recirc In the recirculation loop, the water pressure is displayed and the flow 
rate is controlled by means of a booster pump (to increase the 
pressure). 

Permeate Contains Control Modules to display the flow rate and quality of the 
purified water. 

Brine Contains Control Modules to display the pressure and flow rate of the 
brine discharged. 

MPC Contains the Control Module of the multi-variable controller 
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2.4 Operating the application 

2.4.1 Overview 

All components of reverse osmosis can be operated and monitored via the process 
picture. In addition, the plant operator receives information (KPIs: Key Performance 
Indicators) on the current process state. 

Note Please note that after starting the program (PLCSIM) it takes approx. 2 minutes 
until the reverse osmosis is at the operating point. During the running production 
operation, all controllers are released for operation. You can recognize this state 
for example in the SFC, if it has successfully processed all process steps. 

 

The following two scenarios show different approaches for the compensation of 
fouling at the filter membranes by comparing: 

 Reverse osmosis without multi-variable controller 

 Reverse osmosis with multi-variable controller 

 

2.4.2 Scenario A - Reverse osmosis without multi-variable controller 

In this scenario the process of reverse osmosis is simulated. Pre-purified seawater 
is forced through the filter membranes at high pressure. The filter membranes allow 
only the carrier liquid to pass through and retain the dissolved salt. This leads to 
fouling of the filter membranes, which in turn reduces the quality and quantity of 
drinking water produced. In order to compensate for this effect, the setpoints of the 
inflow and recirculation control must be adjusted again and again. In this scenario, 
the setpoint adjustments must be performed manually by the operator. 

1. Switch to the reverse osmosis process screen.  

 

 

2. Left click the “On/Off” button in the “Tag names” field to display the block 
names. 
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3. Click on the block symbol of the "RO-PIC Feed" block and select "Internal" for 
"Setpoint". Confirm your entry by clicking on "OK". 

 

 

4. Enter the setpoint "57.24" in the faceplate of the "RO-PIC feed" module and 
confirm the entry by clicking on "OK". 

 

5. Repeat steps 3 and 4 for the PID controller "RO-FIC-Recirc" and enter the 
setpoint "728.59". 

6. Switch to the simulation process screen. 
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7. Click on the block symbol of the "Reset_Fouling" block. 
The corresponding faceplate will be opened. 

8. Select the command "On" and confirm your entry with "OK". 

 

 

9. Switch to the reverse osmosis process screen. 

10. Click on the "Retrieve/Compile trend groups" button and select the "Overview" 
trend display. 

11. Open the trend display by clicking on "Display". 

 

 

12. Wait 2 minutes and enter a new setpoint of "57.54" for RO-PIC feed. 

13. Wait another 1 minute and enter a new setpoint of "57.84". 

14. Wait another 2 minutes and enter a new setpoint of "58.24". 

15. Wait 2 minutes and enter a new setpoint of "740" for RO-FIC-Recirc. 

16. Wait another 3 minutes and click on the "Start/Stop" icon to evaluate the rule 
result. 
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Evaluation 

The figure shows the trend curves of reverse osmosis. 

Fouling

Flow rate set point

Recirculation flow rate 

Flow rate after the 
membrane

Upper limit of salinity

Pressure at the membrane

Salinity after the membrane

 

Due to fouling of the filter membranes, the flow resistance of the membrane 
increases. This leads to a deterioration of the quality and reduction of the amount 
of drinking water produced. In order to compensate for the deterioration of product 
properties, the operator must manually increase the setpoint for the PID control 
loop of the high-pressure pump. By increasing the pressure on the filter 
membranes in several steps, the fouling effect can be compensated for about 10 
minutes. After 10 minutes, the control loop of the inflow reaches the manipulated 
variable limits and cleaning of the membrane becomes necessary. 

 

Note Cleaning of the membrane is not a part of this application example. In the 
simulation, only the degree of fouling is reset. 
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2.4.3 Scenario B - Reverse osmosis with multi-variable controller 

In this scenario, the process of reverse osmosis is simulated in the same way as in 
scenario A. In order to compensate for the fouling effects of the filter membranes, 
the setpoints of inflow and recirculation control must be adapted. In this scenario, 
these interventions are not carried out manually by the operator, but automatically 
by the multi-variable master controller. 

1. Switch to the reverse osmosis process screen.  

 

 

2. Left click the “On/Off” button in the “Process tag name” field to display the 
block names. 

3. Click on the block symbol of the SFC "Startup" and click "Start" in the menu 
bar. Confirm your entry by clicking on "OK". 

 

The sequencer set the PID controllers back to automatic mode and to setpoint 
input from the MPC. 

4. Switch to the simulation process screen. 
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5. Click on the block symbol of the "Reset_Fouling" block. 
The corresponding faceplate will be opened. 

6. Click Command on the faceplate and select "On". Confirm your entry by 
clicking on "OK". 

 

 

7. Switch to the process screen of reverse osmosis 

8. Click on the "Retrieve/Compile trend groups" button and select the "Overview" 
trend display. 

9. Open the trend display by clicking on "Display". 

 

 

10. Wait approx. 10 minutes and click on the "Start/Stop" icon to evaluate the rule 
result. 
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Evaluation 

The figure shows the trend curves of reverse osmosis. 

Fouling

Flow rate set point

Recirculation flow rate 

Flow rate after the 
membrane

Upper limit of salinity

Pressure at the membrane

Salinity after the membrane

 

 

Due to fouling of filter membranes, the flow resistance of the membrane increases. 
This leads to a deterioration of the quality and reduction of the amount of drinking 
water produced. As long as salinity after the membrane is lower than the specified 
upper limit, the multi-variable master controller regulates the flow rate after the 
membrane. As soon as salinity after the membrane exceeds the limit, salinity is 
primarily controlled. By increasing the pressure on the filter membranes, the effect 
of fouling on production can be compensated for about 10 minutes. After 10 
minutes, the control loop reaches the manipulated variable limits and cleaning of 
the membrane becomes necessary. 
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3 Integration of unit template into a user 
project 

3.1 Preparation 

1. Copy the file 
"109741119_WUT_SeawaterDesalination_PROJ_PCS7V90SP1.zip" to the 
configuration computer and then open the SIMATIC Manager. 

2. Click on "File > Retrieve" in the menu bar and select the file 
"109741119_WUT_SeawaterDesalination_PROJ_PCS7V90SP1.zip". Then 
confirm by clicking on "Open". 

3. Select the folder in which the project will be saved and confirm with the "OK" 
button. 
The project will be extracted. 

4. In the "Retrieve" dialog, click on the "OK" button and then click on "Yes" in the 
dialog to open the project. 

5. Switch to the "Plant view". 

6. In parallel open the project in which the unit template must be integrated. 

 

3.2 Copying templates 

Note If you have already worked with CMTs in your existing project, then check for 
equality before the following steps, as this can lead to errors in your existing 
project or the unit template to be integrated. 

1. Switch to the plant view. 

2. Copy the CMTs from the master data library and paste them into the target 
project. 

 

 

3. Copy the enumerations from the master data library and paste them into the 
target project. 
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3.3 Copying a plant section 

1. Copy the hierarchy folder "Desalination" from the AS project of the unit 
template into the plant hierarchy of the target project.

 

Note The hierarchy folders of the plant sections "Overview" and "Simulation" are not 
necessary for operation. If you want to operate your system without simulation, 
you do not have to copy them. 

 

2. Copy the process screen "RevOsmosis" from the OS project of the unit 
template into the plant hierarchy of the target project. If necessary, also copy 
the pictures "Simulation" and "Overview". 

 

Note When copying the process screens, make sure that you copy the screens to the 
hierarchy level of the target project that is parameterized as the OS area. 
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3.4 Customizing the OS project 

In order to be able to change the colors in the reverse osmosis process picture at a 
central location, a central color palette was created in the OS project of the Unit 
Template. You must import the central color palette so that these colors are also 
displayed in the process screen of your own project. 

1. Select the "OS" in WinCC Explorer and choose "project properties" in the 
context menu. 

2. Choose the "Interface and Design" tab and click the "Edit" button. 

3. Import the palette with the "Overwrite" option into your own project. The color 
palette is in the project folder under the path: 
"<Project path>\Desalina\Desalina\wincproj\OS\GraCS\Desalination.xml>". All 
existing colors will be replaced. 

 

Note When you export or import the colors, all color tables are always taken into 
account. It is not possible to export individual color tables. 

 

If you have created your own color tables in your project, you can also export these 
and merge the tables with an editor in the XML file. Alternatively, create a new 
color table in your project and define the colors individually. Also make sure that 
the color index does not change, otherwise you would have to adjust the color 
settings of the objects in the process picture. Of course, it is up to you to change 
the colors according to your requirements. 
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Color HTML Code RGB Code 

R G B 

 

3296B9 50 150 185 

 

247087 36 112 135 

 

50BED7 80 190 215 

 

3D93A5 61 147 165 

 

005F87 0 95 135 

 

003C55 0 60 85 

 

00646E 0 100 110 

 

0F8287 15 130 135 

 

494949 73 73 73 

 

6D6D6D 109 109 109 

The following figure shows a simplified representation of how the colors are used in 
the process picture. 
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4 Engineering 

4.1 Control module types 

In this unit template the following Control Module Types from the library "SWL 
PCS7 V90 SP1" are used. 

Control module type Description 

WCMT_MonAnalog Monitoring of an analog measuring point 

WCMT_MotSpdCon Control of a motor via a frequency converter (FU) with 
infinitely variable speed variation and two directions of 
rotation 

WCMT_PIDConL PID controller with continuous output signal (output 
value) 

A detailed description of the Control Module Types can be found in the paper 
"Standard PCS 7 and S7 Water Templates for the Water Industry" at 
https://support.industry.siemens.com/cs/ww/en/view/78604785 

In addition to the Control Module Types from the "SWL PCS7 V90 SP1" library, the 
Control Module Type "CtrlMPC" from the BMC library is also used. 

Control module type Description 

CtrlMPC MPC multi-variable controller 

A detailed description of the Control Module Types can be found in the paper 
"Equipment Modules for SIMATIC PCS 7 using the example of the Chemical 
Industry" at https://support.industry.siemens.com/cs/ww/en/view/53843373. 

 

https://support.industry.siemens.com/cs/ww/en/view/78604785
https://support.industry.siemens.com/cs/ww/en/view/53843373
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4.1.1 WCMT_MonAnalog 

The Control Module Type "WCMT_MonAnalog" is used to monitor an analog 
measurement tag. 

 

In the application example, from the optional variants, only "MonAnIn" is used. The 
optional variants "PMonAnalog" and "SelFp" require the PCS 7 Industry Library. 

The following Control Modules are of type "WCMT_MonAnalog": 

 TI-Feed  PI-Recirc 

 FI-Feed  PI-Reject 

 JI-Feed  JI-Recirc 

 FI-Permeate  PI-Brine 

 PI-Permeate  FI-Brine 

 QI-Permeate  
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4.1.2 WCMT_MotSpdCon 

The Control Module Type "WCMT_MotSpdCon" is used to control a motor via 
frequency converter with variable speed and two directions of rotation. 

 

In the application example, the variants "OutFwd", "FbkFwd", "OutSpd" and 
"RbkSpd" are parameterized at the instances. Only one direction of rotation is 
required. 

The following drives are of type "WCMT_MotSpdCon": 

 NI-Feed 

 NI-Recirc 
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4.1.3 WCMT_PIDConL 

The Control Module Type "WCMT_PIDConL" is a PID controller with continuous 
output signal (manipulated variable). The PID controller can be used for fixed-
value, cascade, ratio, split-range, Smith predictor and override control. 

 

The controller is used in the Unit Template to control the pressure at the membrane 
and the flow of recirculation. No options are activated at the type instances used. 

The following controllers are of type "WCMT_PIDConL": 

 PIC-Feed 

 FIC-Recirc 
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4.1.4 CtrlMPC 

The CMT "CtrlMPC" is used for multi-variable control. In contrast to the "Ctrl", the 
multi-variable controller can handle up to four dependent manipulated and 
controlled variables. MPC is short for "Model Predictive Control". 

 

The multi-variable controller is used in the Unit Template to directly control the 
target values permeate flow and salinity of the permeate, thus compensating for 
the effect of "fouling" at the membrane. The following options are activated for the 
type instances used: 

 Opt_Ctrl_1 

 Opt_Ctrl_2 

 Opt_Ctrl_3 

 Opt_Ctrl_4 

The controller "XC_Desalination" is of type "CtrlMPC": 
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4.2 Equipment Modules and Control Modules 

The Equipment Modules are described in detail in the following section. The basis 
for programming the AS are predefined Control Module Types from the water 
industry. The description of the used Control Module Types can be found in section 
4.1 

4.2.1 Inflow (Feed) 

The pre-cleaned sea water from the ultrafiltration is transported via the inflow to 
reverse osmosis unit. In order to exploit the existing pressure of the retentate, part 
of the fresh sea water is passed through the pressure exchanger (energy recovery 
device). The high-pressure pump generates the required pressure at the 
membrane. The pressure level is specified as the setpoint at the controller. 

Setup 

PIC
Feed

Pre-Treatment

Membrane

TI
Feed

FI
Feed

NI
Feed

Pressure

Exchange

JI
Feed

 

The following Control Modules are used in the "Feed" area of the plant section: 

Control module Control module type Variants Description 

RO-FI-Feed WCMT_MonAnalog MonAnIn Flow measurement (m³/h) 

RO-TI-Feed WCMT_MonAnalog MonAnIn Temperature measurement (°C) 

RO-JI-Feed WCMT_MonAnalog MonAnIn Power measurement (kW) 

RO-NI-Feed WCMT_MotSpdCon OutFwd 

OutSpeed 

FbkFwd 

RbkSpeed 

Variable speed drive 

RO-PIC-Feed WCMT_PIDConL PV_In Pressure controller 
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Parameter assignment 

RO-FI-Feed 

The following parameters were changed from the default values during project 
planning: 

Block Parameters Value Description 

MonAnIn 
I 

Scale.High 

Scale.Low 

2000 

0 

Measuring range of the Control 
Module 

PV_InUnit 1349 Unit of measurement of the Control 
Module (m³/h) 

I PV_WL_Lim 300.0 Warning low limit 

PV_AL_Lim 200.0 Alarm Low limit 

PV_AH_En 0 Alarm High (Off) 

PV_WH_En 0 Warning High (Off) 

GradHUpEn 0 Gradient High Alarm upwards (Off) 

GradHDnEn 0 Gradient High Alarm downwards 
(Off) 

 

The following connections have been added in addition to the standard connection: 

Block Connection Target Description 

MonAnIn SimOn SIM_On_Off.Activate Activates/deactivates the 
simulation 

SimPV_In SIM_FI_Feed.SIM_VAL Simulated process value 

I MsgLock SFC "Start-up” Message lock during start-up 

PV_Out SIM_Feed+Reci.In1 Calculation for the simulation 

 

RO-TI-Feed 

The following parameters were changed from the default values during project 
planning: 

Block Parameters Value Description 

MonAnIn 
I 

Scale.High 

Scale.Low 

80 

0 

Measuring range of the Control 
Module 

PV_InUnit 1001 Unit of measurement of the Control 
Module (°C) 

I PV_AH_En 0 Alarm High (Off) 

PV_WH_En 0 Warning High (Off) 

PV_AL_En 0 Alarm Low (Off) 

PV_WL_En 0 Warning Low (Off) 

GradHUpEn 0 Gradient High Alarm upwards (Off) 

GradHDnEn 0 Gradient High Alarm downwards 
(Off) 
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The following connections have been added in addition to the standard connection: 

Block Connection Target Description 

MonAnIn SimOn SIM_On_Off.Activate Activates/deactivates the 
simulation 

SimPV_In SIM_TI_Feed.Out Simulated process value 

 

RO-JI-Feed 

The following parameters were changed from the default values during project 
planning: 

Block Parameters Value Description 

MonAnIn 
I 

Scale.High 

Scale.Low 

1300.0 

0 

Measuring range of the Control 
Module 

PV_InUnit 1190 Unit of measurement of the Control 
Module (kW) 

I PV_AH_En 0 Alarm High (Off) 

PV_WH_En 0 Warning High (Off) 

PV_AL_En 0 Alarm Low (Off) 

PV_WL_En 0 Warning Low (Off) 

GradHUpEn 0 Gradient High Alarm upwards (Off) 

GradHDnEn 0 Gradient High Alarm downwards 
(Off) 

 

The following connections have been added in addition to the standard connection: 

Block Connection Target Description 

MonAnIn SimOn SIM_On_Off.Activate Activates/deactivates the 
simulation 

SimPV_In SIM_JI_Feed.Out Simulated process value 

to_MPC ReStru1 C.PV_Out Merge connection to MPC 

BoStru1 CSF.Out 

BoStru2 OosAct.Out 

Int1 MonAnIn.PV_OutUnit 

Scale1 MonAnIn.Scale.Out 

Out XC_Desalination\from_CV3.In Connection to MPC  

 

RO-NI-Feed 

All parameters were used with the default values. 

 

These connections have been added in addition to the standard: 

Block Connection Target Description 

FbkFwd SimOn SIM_On_Off.Activate Activates/deactivates the 
simulation 

SimPV_In SIM_NI_Feed.FbkFwd_Out Simulated process value 

RbkSpeed SimOn SIM_On_Off.Activate Activates/deactivates the 
simulation 

SimPV_In SIM_NI_Feed.Spd_Out Simulated process value 



4 Engineering 

 

Reverse osmosis 
Entry ID: 109741119,    V1.0,    10/2018   30 
 


 S

ie
m

e
n

s
 A

G
 2

0
1

8
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

Block Connection Target Description 

N Fwd SIM_NI_Feed.CmdFwd Start signal for the simulation 

SP_Out SIM_NI_Feed.SP_SPD Target value for simulation 

SP_Ext RO-PIC-Feed\C.MV Control value of the controller 

ModLiOp SFC "Start-up” A detailed description of the 
SFC can be found in the 
section:4.2.7 

AutModLi SFC "Start-up” 

ManModLi SFC "Start-up” 

SP_LiOp SFC "Start-up” 

SP_ExtLi SFC "Start-up” 

FbkFwdOut SFC "Start-up” 

AutAct SFC "Start-up” 

SP_ExtAct SFC "Start-up” 

 

RO-PIC-Feed 

The following parameters were changed from the default values during project 
planning: 

Block Parameters Value Description 

C Gain 0.6 Controller gain 

TI 8 Controller delay time 

SP_Int 57.24 Internal setpoint 

PV_AH_Lim 80 Alarm high limit 

PV_WH_LIM 75 Warning high limit 

PV_WL_Lim 55 Warning low limit 

PV_AL_Lim 50 Alarm Low limit 

SP_InHiLim 100 Set point range corresponding to the 
measuring range of the Control Module 

SP_InLoLim 0 

PV_In PV_InUnit 1137 Unit of measurement of the process value 
(bar) 

 

The following connections were added to the standard: 

Block Connection Target Description 

C SP to_Master.ReStru1 Merge connection to 
MPC 

SP_InHiOut to_Master.ReStru2 

SP_InLoOut to_Master.ReStru3 

PV_Out to_Master.ReStru4 

CasaCut to_Master.BoStru1 

LockAct to_Master.BoStru3 

SP_Ext from_Master.Restruc1 Disconnect wiring 
from MPC 

ModLiOp SFC "Start-up” A detailed 
description of the 
SFC can be found in 
the section:4.2.7 

AutModLi 

ManModLi 

SP_LiOp 

SP_ExtLi 
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Block Connection Target Description 

SP_IntLi 

AutAct 

SP_ExtAct 

SP 

PV_WH_Ac 

OosAct Out to_Master.BoStru2 Merge connection to 
MPC 

PV_In PV_In.PV_OutUnit to_Master.Int1 

PV_In.ScaleOut to_Master.Scale1 

to_Master Out XC_Desalination\from_Ctrl1.In Connection to MPC  

from_Master In XC_Desalination\to_Ctrl1.Out Connection from 
MPC  

 

4.2.2 Recirculation 

The fresh sea water, which has been lifted to a higher pressure level by the 
pressure exchanger, is pumped to the membrane by the booster pump. The flow 
rate to be pumped is specified as the flow setpoint at the controller: 

Setup 

Pre-Treatment

Pressure

Exchange

Membrane

PI
Recirc

FIC
Recirc

NI
Recirc

JI
Recirc

 

The following Control Modules are used in the "Recirc" plant section area: 

Control module Control module type Variants Description 

RO-PI-Recirc WCMT_MonAnalog MonAnIn Pressure measurement (bar) 

RO-JI-Recirc WCMT_MonAnalog MonAnIn Power measurement (kW) 

RO-NI-Recirc WCMT_MotSpdCon OutFwd 

OutSpeed 

FbkFwd 

RbkSpeed 

Variable speed drive 

RO-FIC-Recirc WCMT_PIDConL PV_In Flow controller  
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Parameter assignment 

RO-PI-Recirc 

The following parameters were changed from the default values during project 
planning: 

Block Parameters Value Description 

MonAnIn 
I 

Scale.High 

Scale.Low 

90.0 

0 

Measuring range of the Control 
Module 

PV_InUnit 1137 Unit of measurement of the Control 
Module (bar) 

I PV_AH_En 0 Alarm High (Off) 

PV_WH_En 0 Warning High (Off) 

PV_AL_En 0 Alarm Low (Off) 

PV_WL_En 0 Warning Low (Off) 

GradHUpEn 0 Gradient High Alarm upwards (Off) 

GradHDnEn 0 Gradient High Alarm downwards 
(Off) 

 

The following connections have been added in addition to the standard connection: 

Block Connection Target Description 

MonAnIn SimOn SIM_On_Off.Activate Activates/deactivates the 
simulation 

SimPV_In SIM_PI-Recirc.Out Simulated process value 

I MsgLock SFC "Start-up” Message lock during start-up 

 

RO-JI-Recirc 

The following parameters were changed from the default values during project 
planning: 

Block Parameters Value Description 

MonAnIn 
I 

Scale.High 

Scale.Low 

140.0 

0 

Measuring range of the Control 
Module 

PV_InUnit 1190 Unit of measurement of the Control 
Module (kW) 

I PV_AH_En 0 High alarm (Off) 

PV_WH_En 0 High warning (Off) 

PV_AL_En 0 Low alarm (Off) 

PV_WL_En 0 Low Warning (Off) 

GradHUpEn 0 Gradient High Alarm upwards (Off) 

GradHDnEn 0 Gradient High Alarm downwards 
(Off) 
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The following connections have been added in addition to the standard connection: 

Block Connection Target Description 

MonAnIn SimOn SIM_On_Off.Activate Activates/deactivates the 
simulation 

SimPV_In SIM_JI_Feed.Out Simulated process value 

to_MPC ReStru1 C.PV_Out Merge connection to MPC 

BoStru1 CSF.Out 

BoStru2 OosAct.Out 

Int1 MonAnIn.PV_OutUnit 

Scale1 MonAnIn.Scale.Out 

Out XC_Desalination\from_CV4.In Connection to MPC  

 

RO-NI-Recirc 

All parameters were used with the default values. 

 

These connections have been added in addition to the standard 

Block Connection Target Description 

FbkFwd SimOn SIM_On_Off.Activate Activates/deactivates the 
simulation 

SimPV_In SIM_NI_Recric.FbkFwd_Out Simulated process value 

RbkSpeed SimOn SIM_On_Off.Activate Activates/deactivates the 
simulation 

SimPV_In SIM_NI_Recirc.Spd_Out Simulated process value 

N Fwd SIM_NI_Recirc.CmdFwd Start signal for the simulation 

SP_Out SIM_NI_Recirc.SP_SPD Target value for simulation 

SP_Ext RO-FIC-Recirc\C.MV Control value of the controller 

ModLiOp SFC "Start-up” A detailed description of the 
SFC can be found in the 
section:4.2.7 

AutModLi SFC "Start-up” 

ManModLi SFC "Start-up” 

SP_LiOp SFC "Start-up” 

SP_ExtLi SFC "Start-up” 

FbkFwdOut SFC "Start-up” 

AutAct SFC "Start-up” 

SP_ExtAct SFC "Start-up” 
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RO-FIC-Recirc 

The following parameters were changed from the default values during project 
planning: 

Block Parameters Value Description 

C Gain 0.16 Controller gain 

TI 4.7 Controller delay time 

SP_Int 728.6 Internal setpoint 

PV_AH_En 80 Alarm High (Off) 

PV_WH_En 75 Warning High (Off) 

PV_WL_En 55 Alarm Low (Off) 

PV_AL_Em 50 Warning Low (Off) 

SP_InHiLim 900 Set point range corresponding to the 
measuring range of the Control Module 

SP_InLoLim 0 

PV_In PV_InUnit 1349 Unit of measurement of the process value 
(m³/h) 

The following connections were added to the standard: 

Block Connection Target Description 

C SP to_Master.ReStru1 Merge connection to 
MPC 

SP_InHiOut to_Master.ReStru2 

SP_InLoOut to_Master.ReStru3 

PV_Out to_Master.ReStru4 

CasaCut to_Master.BoStru1 

LockAct to_Master.BoStru3 

SP_Ext from_Master.Restruc1 Disconnect wiring from 
MPC 

ModLiOp SFC "Start-up” A detailed description of 
the SFC can be found in 
the section:4.2.7 

AutModLi 

ManModLi 

SP_LiOp 

SP_ExtLi 

SP_IntLi 

AutAct 

SP_ExtAct 

SP 

PV_WH_Ac 

OosAct Out to_Master.BoStru2 Merge connection to 
MPC 

PV_In PV_OutUnit to_Master.Int1 

ScaleOut to_Master.Scale1 

to_Master Out XC_Desalination\from_Ctrl2.In Connection to MPC  

from_Master In XC_Desalination\to_Ctrl2.Out Connection from MPC  
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4.2.3 Permeate 

Here, the residual salinity and the quantity of desalinated seawater are recorded. 

Setup 

Membrane

Permeate

PI
Permeate

FI
Permeate

QI
Permeate  

The following Control Modules are used in the "Permeate" plant section: 

Control module Control module type Variants Description 

RO-FI-Permeate WCMT_MonAnalog MonAnIn Flow measurement (m³/h) 

RO-PI-Permeate WCMT_MonAnalog MonAnIn Pressure measurement (bar) 

RO-QI-Permeate WCMT_MonAnalog MonAnIn Measurement of conductivity 
(µS/cm) 

In addition to conductivity, the quality of the product can also be represented by 
salinity. For this purpose, the salinity is calculated in simplified form using the 
following linear conversion factor: 

1
g

L
 =̂  1226.1

µS

cm
 

Conductivity 𝑆 is usually measured at a real plant. However, the conversion into 
salinity must be carried out individually. Conductivity depends, for example, on salt 
composition, pressure and temperature. 

 

Parameter assignment 

RO-FI-Permeate 

The following parameters were changed from the default values during project 
planning: 

Block Parameters Value Description 

MonAnIn 
I 

Scale.High 

Scale.Low 

2000 

0 

Measuring range of the Control 
Module 

PV_InUnit 1349 Unit of measurement of the Control 
Module (m³/h) 

I PV_WL_Lim 100.0 Warning low limit 

PV_AL_Lim 80.0 Alarm Low limit 

PV_AH_En 0 Alarm High (Off) 

PV_WH_En 0 Warning High (Off) 

GradHUpEn 0 Gradient High Alarm upwards (Off) 

GradHDnEn 0 Gradient High Alarm downwards 
(Off) 
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The following connections have been added in addition to the standard connection: 

Block Connection Target Description 

MonAnIn SimOn SIM_On_Off.Activate Activates/deactivates the 
simulation 

SimPV_In F_Factor.Out Simulated process value 

I MsgLock SFC "Start-up” Message lock during start-up 

PV_Out SIM_FI_Brine.In2 Calculation for the simulation 

to_MPC ReStru1 C.PV_Out Merge connection to MPC 

BoStru1 CSF.Out 

BoStru2 OosAct.Out 

Int1 MonAnIn.PV_OutUnit 

Scale1 MonAnIn.Scale.Out 

Out XC_Desalination\from_CV2.In Connection to MPC  

 

RO-PI-Permeate 

The following parameters were changed from the default values during project 
planning: 

Block Parameters Value Description 

MonAnIn 
I 

 

Scale.High 

Scale.Low 

90.0 

0 

Measuring range of the Control 
Module 

PV_InUnit 1137 Unit of measurement of the Control 
Module (bar) 

PV_AH_En 0 Alarm High (Off) 

PV_WH_En 0 Warning High (Off) 

PV_AL_En 0 Alarm Low (Off) 

PV_WL_En 0 Warning Low (Off) 

GradHUpEn 0 Gradient High Alarm upwards (Off) 

GradHDnEn 0 Gradient High Alarm downwards 
(Off) 

The following connections have been added in addition to the standard connection: 

Block Connection Target Description 

MonAnIn SimOn SIM_On_Off.Activate Activates/deactivates the 
simulation 

SimPV_In SIM_PI-Permeate.Out Simulated process value 
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RO-QI-Feed 

The following parameters were changed from the default values during project 
planning: 

Block Parameters Value Description 

MonAnIn 
I 

Scale.High 

Scale.Low 

1800.0 

0 

Measuring range of the Control 
Module 

PV_InUnit 0 Unit of measurement of the Control 
Module (µS/cm) 

PV_AH_Lim 1300 Alarm high limit 

PV_WH_LIM 1280 Warning high limit 

PV_AL_En 0 Alarm Low (Off) 

PV_WL_En 0 Warning Low (Off) 

GradHUpEn 0 Gradient High Alarm upwards (Off) 

GradHDnEn 0 Gradient High Alarm downwards 
(Off) 

 

The following connections have been added in addition to the standard connection: 

Block Connection Target Description 

MonAnIn SimOn SIM_On_Off.Activate Activates/deactivates the 
simulation 

SimPV_In SIM_JI_Feed.Out Simulated process value 

to_MPC ReStru1 C.PV_Out Merge connection to MPC 

BoStru1 CSF.Out 

BoStru2 OosAct.Out 

Int1 MonAnIn.PV_OutUnit 

Scale1 MonAnIn.Scale.Out 

Out XC_Desalination\from_CV1.In Connection to MPC  
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4.2.4 Brine 

In this system area, the pressure of the retentate is measured and the pressure is 
transferred to the fresh seawater by the pressure exchanger. Flow of the brine is 
recorded in the discharge pipe. 

Setup: 

Membrane

Brine

PI
Brine

FI
Brine

PI
Reject

Pressure

Exchange

 

In the Equipment Modules "Brine" the following Control Modules are used: 

Control module Control module type Variants Description 

RO-FI-Brine WCMT_MonAnalog MonAnIn Flow measurement (m³/h) 

RO-PI-Brine WCMT_MonAnalog MonAnIn Pressure measurement (bar) 

RO-PI-Reject WCMT_MonAnalog MonAnIn Pressure measurement (bar) 

 

Parameter assignment 

RO-FI-Brine 

The following parameters were changed from the default values during project 
planning: 

Block Parameters Value Description 

MonAnIn 
I 

Scale.High 

Scale.Low 

1000.0 

0 

Measuring range of the Control 
Module 

PV_InUnit 1349 Unit of measurement of the Control 
Module (m³/h) 

I PV_AH_En 0 Alarm High (Off) 

PV_WH_En 0 Warning High (Off) 

PV_AL_En 0 Alarm Low (Off) 

PV_WL_En 0 Warning Low (Off) 

GradHUpEn 0 Gradient High Alarm upwards (Off) 

GradHDnEn 0 Gradient High Alarm downwards 
(Off) 

 

The following connections have been added in addition to the standard connection: 

Block Connection Target Description 

MonAnIn SimOn SIM_On_Off.Activate Activates/deactivates the 
simulation 

SimPV_In SIM_FI_Brine Simulated process value 

PV_Out SIM_FI_Brine.In2 Calculation for the simulation 
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RO-PI-Brine 

The following parameters were changed from the default values during project 
planning: 

Block Parameters Value Description 

MonAnIn 
I 

Scale.High 

Scale.Low 

90.0 

0 

Measuring range of the Control 
Module 

PV_InUnit 1137 Unit of measurement of the Control 
Module (bar) 

PV_AH_En 0 Alarm High (Off) 

PV_WH_En 0 Warning High (Off) 

PV_AL_En 0 Alarm Low (Off) 

PV_WL_En 0 Warning Low (Off) 

GradHUpEn 0 Gradient High Alarm upwards (Off) 

GradHDnEn 0 Gradient High Alarm downwards 
(Off) 

The following connections have been added in addition to the standard connection: 

Block Connection Target Description 

MonAnIn SimOn SIM_On_Off.Activate Activates/deactivates the 
simulation 

SimPV_In SIM_PI-Brine.Out Simulated process value 

 

RO-PI-Reject 

The following parameters were changed from the default values during project 
planning: 

Block Parameters Value Description 

MonAnIn 
I 

Scale.High 

Scale.Low 

90.0 

0 

Measuring range of the Control 
Module 

PV_InUnit 1137 Unit of measurement of the Control 
Module (bar) 

PV_AH_En 0 Alarm High (Off) 

PV_WH_En 0 Warning High (Off) 

PV_AL_En 0 Alarm Low (Off) 

PV_WL_En 0 Warning Low (Off) 

GradHUpEn 0 Gradient High Alarm upwards (Off) 

GradHDnEn 0 Gradient High Alarm downwards 
(Off) 

The following connections have been added in addition to the standard connection: 

Block Connection Target Description 

MonAnIn SimOn SIM_On_Off.Activate Activates/deactivates the 
simulation 

SimPV_In SIM_PI-Reject.Out Simulated process value 
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4.2.5 Salinity and flow rate (desalination) 

The multi-variable control system regulates flow rate and salt concentration of 
water as a measure of product quality. For this purpose, the controller delivers its 
output values as external setpoints to the slave controllers for feed pressure and 
recirculation flow. 

Product quality (salinity) has the highest priority but remains within its dead zone 
during normal operation. The controller only has to intervene if the salinity should 
be higher than permitted. Therefore, the main control variable in normal operation 
is the production output (permeate flow).  

The electrical power consumption of high-pressure pump and booster pump are 
low-priority controlled variables. The target values correspond to the operating 
points with optimum pump efficiency. 

Setup 

PIC
Feed

Pre-Treatment

Pressure

Exchange

Membrane

Permeate

Brine

NI
Feed

FIC
Recirc

NI
Recirc

JI
Feed

JI
Recirc

XC
Desalination

PI
Permeate

FI
Permeate

The following Control Modules are used in the "Desalination" plant section: 

Control module Control module type Variants Description 

RO-XC-Desalination CtrlMPC Opt_Ctrl_1 

Opt_Ctrl_2 

Opt_Ctrl_3 

Opt_Ctrl_4 

Multi-variable controller as 
master controller 

 

Parameter assignment 

RO-XC-Desalination 

The Control Module contains communication blocks for connecting slave 
controllers and for displaying controlled variables, and is an instance of the Control 
Module Type "CtrlMPC". The communication blocks are connected to the following 
variables. 

CVs (Controlled Variables): 

 Salinity after membrane (RO-QI-Permante) 

 Flow after membrane (RO-FI-Permante) 

 High-pressure pump power consumption (RO-JI feed) 

 Booster pump power consumption (RO-JI-Recirc) 
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MVs (Manipulated Variables, setpoint values for slave controllers): 

 Feed pressure (RO-PIC feed) 

 Recirculation flow rate (RO-FIC-Recirc) 

 

The following parameters were changed from the default values during project 
planning: 

Block Parameters Value Description 

MPC 

 

SP1 533.31 Setpoint setting for the process value 
1 

SP2 475.0 Setpoint setting for process value 2 

SP3 913.0 Setpoint setting for process value 3 

SP4 65.0 Setpoint setting for process value 4 

PreFilt1 24.0 Settling time in s of setpoint filter for 
setpoint SP1 

PreFilt1 36.0 Settling time in s of setpoint filter for 
setpoint SP2 

MV1Man 55.0 Control value in manual mode 

MV2Man 700.0 Control value in manual mode 

DB_No 18 DB number with controller data 

DeadBand_SP1 In1 606.92 Upper limit of the deadband 

 

The following connections have been added in addition to the standard connection: 

Block Connection Target Description 

MPC SP1DeadB 
RO-XC-
Desalination\Limit_Deadband.Out 

Dead band for set value 1 

MPC SP1OpOut 
RO-XC-
Desalination\DeadBand_SP1.In2t 

Calculate the dead band 
from the target value 

to_Ctrl1 Out 
RO-PIC_Feed\from_Master.In Control value for the inlet 

pressure 

to_Ctrl2 Out 
RO-FIC_Recirc\from_Master.In Control value for 

recirculation flow rate 

from_Ctrl1 In 

RO-PIC_Feed\to_Master.Out Connection from the 
Control Module Inlet 
pressure 

from_Ctrl2 In 
RO-FIC_Recirc\to_Master.Out Connection of the Control 

Module Recirculation 

from_CV1 In RO-QI-Permate\to_MPC.Out Connection of salinity 
display 

from_CV2 In RO-FI-Permate\to_MPC.Out Connection of flow rate 
indicator 

from_CV3 In RO-JI-Feed\to_MPC.Out Connection to high-
pressure pump display 

from_CV4 In RO-JI-Recirc\to_MPC.Out Connection to booster 
pump display 
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4.2.6 Process simulation (simulation) 

The task of process simulation is to understand or demonstrate the functionality of 
reverse osmosis, especially with regard to the control functions of the multi-variable 
controller. There is no claim of exactly reproducing the real physical behavior of a 
certain desalination plant.  

Simulation of the membrane 

For process simulation, a matrix of linear dynamic transfer functions is used as a 
model. The process model is a 2x4 multi-variable system in which the influence of 
each input variable to each output variable is simulated by a separate partial 
transfer function. The model describes the temporal behavior of process deviations 
from the operating point. The process simulation runs in real time, only the fouling 
process runs in time-lapse, i.e. 240 times faster than real time. This means a 
cleaning of the membrane is necessary after 10 minutes. 

RO-NI-Feed RO-NI-Recirc

QI_Permeate G11 G12

FI_Permeate G21 G22

JI_Feed G31 G32

JI_Recirc G41 G42

Input variables

O
u
tp

u
t 
v
a
ri
a
b
le

s

 

In the simulation plan "Sim_Membran" the process variables of the MPC are 
calculated. Operating points, delays and interactions are defined for each process 
variable. The dynamic model describes deviations from the operating point for the 
respective process variable. 
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For the transfer functions G11, G21, G31, G32, G41 and G42 a first-order delay 
function (PT1 behavior) around the operating point is simulated. 

1

2 3

 

1. Calculation of the deviation from the operating point 

2. First order delay element 

3. Gain 

 

The transfer functions G12 and G22 cannot be realistically simulated by first-order 
delay functions (PT1 behavior). Therefore, for these two transfer functions, the 
form 

𝐺(𝑠)  =  𝐾𝑝  ∙
1+𝑇𝑧∙𝑠 

(1+𝑇𝑝1∙𝑠)(1+𝑇𝑝1∙𝑠)
 is selected 

1

1

2

3

4

 

1. Calculation of the deviation from the operating point 

2. Transfer function 

3. Influence of fouling 

4. Conversion to conductivity 
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Note The conversion of salinity to conductivity (measurable at the real plant) is carried 
out for the template in simplified form with the following linear conversion factor: 

1
g

L
 =̂  1226.1

µS

cm
 

In a real plant, the actual salinity can only be calculated from the measured 
conductivity. The conversion depends on salt composition, pressure and 
temperature and must be calibrated individually. 

 

Process simulation 

In the simulation plan "Simulation" the process variables of the two PID controllers 
are calculated. Operating points, delays and interactions are defined for each 
process variable. The dynamic model describes deviations from the operating point 
for the respective process variable. 

1

2 3

2

1

2 3

2

 

1. Simulation of a motor with two directions of rotation and variable speed 

2. Scaling to the operating point 

3. Simulation of the process behavior (PT1 element) 
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A plan-in-plan module is used to simulate a motor with two directions of rotation 
and variable speed. The following table shows the input parameters of the block. 

Parameters Type Description 

SP_SPD STRUCT 

Value: REAL 

ST: BYTE 

Analog setpoint of the engine 

SP_Scale STRUCT 

High: REAL 

Low: REAl 

Setpoint limits of the engine 

Scale STRUCT 

High: REAL 

Low: REAL 

Scaling of the motor in revolutions per minute 

CmdFwd STRUCT 

Value: BOOL 

ST: BYTE 

Command to start the engine in forward direction 

CmdRev STRUCT 

Value: BOOL 

ST: BYTE 

Command to start the engine in reverse direction 

Kp STRUCT 

Value: REAL 

ST: BYTE 

Engine gain factor 

Tv REAL Delay time of the engine (PT1 behavior) 

 

The following table shows the output parameters of the block. 

Parameters Type Description 

SPD_Out STRUCT 

Value: REAL 

ST: BYTE 

Analog output value of the engine in percent 

SPDU_Out STRUCT 

Value: REAL 

ST: BYTE 

Analog output value of the engine in revolutions 
per minute 

SP_Scale_Out STRUCT 

High: REAL 

Low: REAL 

Output of the scaling of the engine in percent 

Scale_Out STRUCT 

High: REAL 

Low: REAL 

Output of the scaling of the engine in revolutions 
per minute 

FbkFwd STRUCT 

Value: BOOL 

ST: BYTE 

Feedback of the engine in forward direction 

FbkRev STRUCT 

Value: BOOL 

ST: BYTE 

Feedback of the engine in reverse direction 
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4.2.7 Sequential Function Chart 

After the CPU has been started, the SFC "Startup" drives the system into the 
operating point. The SFC starts the drives and defines setpoints for the controllers. 
The messages of the Control Modules are blocked until all process values are 
within the normal range. The SFC is processed only once after the start of the 
CPU. 

(1) "Lock Messages": 

The messages of the affected blocks are 
blocked. 

(2) "NI-Feed-Link" and "NI-Recirc-Link": 

The operation of the drives is set to 
automatic and the setpoint source is set to 
external. 

(3) "NI-Feed-Start” and "NI-Recirc-Start": 

The drives are started. 

(4) "PIC-Feed-Start" and "FIC-Recirc-Start": 

The operation of the PID controllers is set to 
interconnection and the setpoint source is 
set to internal. 

(5) "Start_MPC". 

Starting the MPC in manual mode and 
setting the output value 

(6)   "PIC-Feed-Ext" and "FIC-Recirc-Ext": 

The operation of the controllers is switched 
over to the external setpoint. 

(7)   "Auto_MPC": 

The MPC is given the setpoints and put into 
automatic mode. 

(8)   "NI-Feed-Op" and "NI-Recirc-Op": 

The usability of the engines is enabled 
again for the operator. 

(9) "PIC-Feed-Op" and "FIC-Recirc-Op”: 

The operation of the controllers is enabled 
again for the operator. 

(10) "MPC-Op" and "FIC-Recirc-Op": 

The operation of the MPC is enabled again 
for the operator. 

(11) "Unlock Messages": 

The messages of the affected blocks are 
released. 

1

2

3

4

5

7

6

8

9

10

11

 

The SFC "Startup" is implemented in the folder "RevOsmosis" of the plant 
hierarchy. 
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4.2.8 Key Performance Indicators (KPI) 

The CFC "KPI" contains key figures that inform the operator about the performance 
of the process. The following key performance indicators are calculated and 
displayed in the visualization: 

1. Sheet: Specific energy consumption: The specific energy consumption is 
calculated from the ratio of total power consumption to volume flow. The total 
power is calculated by adding the power of the high-pressure pump and the 

booster pump. The outgoing volume flow 𝑉̇𝑃𝑒𝑟𝑚𝑎𝑡𝑒 corresponds to the permeate 
product outflow. 

𝑆𝐸𝐶 =
𝑃Feed + 𝑃Recirc

𝑉̇Permeate

 

 

2. Sheet: Overall energy consumption (OverallEnergy): The energy consumption 
describes the energy consumed since the last cleaning of the membrane and 
is calculated from the time integral of the power consumption of the two 
pumps. 

𝐸consumption = ∫(𝑃Feed + 𝑃Recirc) d𝑡 

 

3. Sheet: Produced quantity (OverallProduction): The quantity produced 
describes the quantity of drinking water produced since the last purification of 
the membrane and is calculated from the time integral of the volume flow of the 
desalinated water. 

𝑉Product = ∫ 𝑉̇Permeate d𝑡 
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5 Basics 

5.1 P&I diagram 

The following P&ID shows the process of reverse osmosis within a seawater 
desalination plant. This process is described in more detail in this application 
example. 

Pre-Treatment

Pressure

Exchange

Membrane

TI
Feed

FI
Feed

Permeate

Brine

PI
Brine

FI
Brine

NI
Feed

PI
Recirc

NI
Recirc

PI
Reject

QI
Permeate

JI
Feed

JI
Recirc

PI
Permeate

FI
Permeate

PIC
Feed

XC
Desalination

PIC
Recirc

 

5.2 Project structure 

5.2.1 Naming conventions 

For the composition of the process tags a uniform naming convention is used, 
which corresponds to the European standard EN 62424. As shown here using the 
example of a process tag for pressure recording, the process tag designations in 
the AS program are structured as follows: 

RO-PI-Feed

Plant code: RO (Reverse Osmosis)

First letter: P-pressure

Next letter: I - indicator

Measuring point code
 

The following tables contain the designations used in this application example and 
their meaning: 

First letter Meaning 

F Flow 

J Power 

L Level 

M Moisture 

N Engine 
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First letter Meaning 

P Pressure 

Q Amount, quantity or quality 

S Speed (velocity, rotational speed, frequency) 

T Temperature 

X Freely selectable first letter 

Y Control valve 

 

Next letter Meaning 

A Alarming/Messages 

C Control 

F Fraction 

I Indication 

R Recording/Storage 

S Switching function or binary control function (not safety-relevant)  

 

5.2.2 Plant view 

The SIMATIC PCS 7 project is created as a multi-project "Desalination_MP" and 
contains the following subprojects: 

 Desalination_AS 
Contains the hardware configuration of the AS and the AS program. 

 Desalination_OS 
Contains the configuration of the OS and the OS project. 

 Desalination_Lib 
The master data library provides all the components used. 

The plant hierarchy is defined with three levels (plant, plant section and Equipment 
Module) and the OS level is defined as level 2. The AS program for seawater 
desalination is set up in the "RevOsmosis" plant unit. 

The 'RevOsmosis' unit contains the Equipment Modules in which the CFCs are 
located. 

The process picture of reverse osmosis is displayed at the operator station in the 
plant area "RevOsmosis". The process screen contains the Control Modules of all 
Equipment Modules. 
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The following figure shows the structure of the PCS 7 multi-project. 

 

Desalination

Desalination

RevOsmosis

AS - Project

OS - Project

SFC

Startup

Birne

CFC

RO_FI_Brine

CFC

RO_PI_Brine

CFC

RO_PI_Reject

Feed

CFC

RO_FI_Feed

CFC

RO_JI_Feed

CFC

RO_TI_Feed

CFC

RO_NI_Feed

CFC

RO_PIC_Feed

RevOsmosis

RevOsmosis

PDL

Overview

Overview

PDL

Simulation

Simulation

PDL

Permeate

CFC

RO_FI_Permeate

CFC

RO_QI_Permeate

CFC

RO_PI_Permeate

Recirc

CFC

RO_JI_Recirc

CFC

RO_NI_Recirc

CFC

RO_FIC_Recirc

RevOsmosis

CFC

RO_FI_Permeate

CFC

RO_QI_Permeate

CFC

RO_PI_Permeate

MPC

CFC

RO_XC_Desalination

RevOsmosis

CFC

SIM_On_Off

CFC

Simulation

CFC

SIM_Membran

CFC

KPI
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5.3 Components of Unit Template  

The desalination process is realized with the following components: 

 High pressure pump 

 Osmosis membranes 

 Pressure exchanger 

 Booster pump 

 Control Modules for recording pressure, flow rate, performance, quality and 
temperature 

 

1

2

3

4

 

1. Analog process tag 

2. Pump drive with PID control 

3. Sequential function chart "Startup" 

4. MPC 
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Startup 

After you start the CPU, the SFC "Startup" is executed. You can check the status 
of the SFC at the block symbol with the corresponding faceplate and restart the 
sequencer if necessary. 

 

PID control 

The drives "NI-Feed" and "NI-Recirc" are controlled by a PID controller. The 
controller "PIC-Feed" controls the pressure "PI-Feed" at the osmosis membrane. 
The controller "FIC-Recirc" regulates the flow "FI-Recirc" of fresh sea water, which 
has been brought to a higher pressure level by the pressure exchanger. 

 

The setpoints for PID control of pressure and flow are specified by the multi-
variable controller. 
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MPC 

The PID controllers "PIC-Feed" and "FIC-Recirc" receive the setpoints from a 
master multi-variable controller. The multi-variable controller commands up to four 
interacting manipulated and controlled variables as well as one measurable 
disturbance variable. In this case, the flow rate and the quality of the product are 
read and the manipulated variables for the desalination process are calculated.  

 

 

5.4 Connect Control Modules  

For the next steps, make sure that the hardware devices including peripherals are 
completely configured in your project. You should parameterize all used inputs and 
outputs of the periphery with symbol names. Name the symbols in the same way 
as the corresponding process tag names. E.g. the following symbolic names are 
used to control the high pressure pump: 

Address Symbol Data type Comment 

IW 516 RO-PI-Feed-In WORD Feed Pressure 

IW 518 RO-NI-Feed-FBSpd WORD Feedback Speed HPP 

I 0.0 RO-NI-Feed-FBFwd BOOL Feedback Run Forward HPP 

QW 515 RO-NI-Feed-SPSpd WORD Setpoint Speed HPP 

Q 0.0 RO-NI-Feed-Start BOOL Starting Forward HPP 
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Then connect the connection "PV_In" or "PV_Out" of all driver blocks to the 
process periphery. 
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6 Appendix 

6.1 Service and support 

Industry Online Support 

Do you have any questions or need assistance?  

Siemens Industry Online Support offers round the clock access to our entire 
service and support know-how and portfolio. 

The Industry Online Support is the central address for information about our 
products, solutions and services.  

Product information, manuals, downloads, FAQs, application examples and videos 
– all information is accessible with just a few mouse clicks: 
https://support.industry.siemens.com 
 

Technical Support 

The Technical Support of Siemens Industry provides you fast and competent 
support regarding all technical queries with numerous tailor-made offers  
– ranging from basic support to individual support contracts. Please send queries 
to Technical Support via Web form: 
www.siemens.com/industry/supportrequest 
 

SITRAIN – Training for Industry  

We support you with our globally available training courses for industry with 
practical experience, innovative learning methods and a concept that’s tailored to 
the customer’s specific needs. 

For more information on our offered trainings and courses, as well as their 
locations and dates, refer to our web page: 
www.siemens.com/sitrain  
 

Service offer 

Our range of services includes the following:  

 Plant data services 

 Spare parts services 

 Repair services 

 On-site and maintenance services 

 Retrofitting and modernization services 

 Service programs and contracts 

You can find detailed information on our range of services in the service catalog 
web page: 
https://support.industry.siemens.com/cs/sc 
 

Industry Online Support app 

You will receive optimum support wherever you are with the "Siemens Industry 
Online Support" app. The app is available for Apple iOS, Android and Windows 
Phone:  
https://support.industry.siemens.com/cs/ww/en/sc/2067 

https://support.industry.siemens.com/
http://www.siemens.com/industry/supportrequest
http://www.siemens.com/sitrain
https://support.industry.siemens.com/cs/sc
https://support.industry.siemens.com/cs/ww/en/sc/2067
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6.2 Links and literature 

No. Topic 

\1\ Siemens Industry Online Support 

https://support.industry.siemens.com 

\2\ Link to this entry page of this application example 

https://support.industry.siemens.com/cs/ww/en/view/109741119 

\3\ Whitepaper: "Optimization of Reverse Osmosis Seawater Desalination Plants by 
Advanced Process Control" 

https://w3.siemens.com/mcms/water-
industry/en/desalination/PublishingImages/whitepaper-reverse-osmosis.pdf 

\4\ Standard PCS 7 and S7 Water Templates for the water industry 

https://support.industry.siemens.com/cs/ww/en/view/78604785 

\5\ SIMATIC Process control system PCS 7 Advanced Process Library (V9.0 SP1) 

https://support.industry.siemens.com/cs/ww/en/view/109754967 

\6\ Controller optimization with PCS 7 PID Tuner 

https://support.industry.siemens.com/cs/ww/en/view/8031495 

 

 

6.3 Change documentation 

Version Date Modifications 

V1.0 10/2018 First version 

   

   

 

 

https://support.industry.siemens.com/
https://support.industry.siemens.com/cs/ww/en/view/109741119
https://w3.siemens.com/mcms/water-industry/en/desalination/PublishingImages/whitepaper-reverse-osmosis.pdf
https://w3.siemens.com/mcms/water-industry/en/desalination/PublishingImages/whitepaper-reverse-osmosis.pdf
https://support.industry.siemens.com/cs/ww/en/view/78604785
https://support.industry.siemens.com/cs/ww/en/view/109754967
https://support.industry.siemens.com/cs/ww/en/view/8031495
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